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Overview

1.1 About eCognition Suite
Trimble® eCognition® Suite is an advanced analysis software available for geospatial applications. It is
designed to improve, accelerate and automate the interpretation of a variety of geospatial data and
enables users to design feature extraction or change detection solutions to transform geospatial data into
geo-information.

eCognition imports a variety of geospatial data, fusing them together into a rich stack of geo-data for the
analysis. The analysis logic is structured into series of steps to create a computer-based representation of
an expert’s geospatial interpretation process a so called Rule Set. eCognition then combines the analysis
logic with scalable computing power to identify changes over time or features on the earth’s surface across
very large sets of data.

This eCognition Suite 10.3 is a major release and includes a range of new features and bug fixes. We
recommend upgrading to this new version to benefit from the new features and improvements. For an
overview of the highlights and a complete list of new features and bug fixes please refer to the following
chapters.

1
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1   Overview

1.2 Key Features

1.2.1 Building Analysis Solutions

The eCognition technology examines image pixels not in isolation, but in context. It builds up a picture
iteratively, recognizing groups of pixels as objects. Just like the human mind, it uses color, shape, texture,
shape and size of objects, as well as their context and relationships, to draw the same conclusions that an
experienced analyst would draw.

To build an analysis solution, it is possible to flexibly combine the image interpretation steps like object
creation (segmentation), object classification (knowledge based, fuzzy logic, machine learning), object
detection (template matching) and object modification (fusing, smoothing, orthogonalization,
simplification) into a Rule Set or even a new application (Rule Set with UI) to solve the analysis problem.

The result is a unique approach to translate mind models (why a human interpreter can see the objects,
changes, or features in the geospatial data) into computer understandable code (Rule Set) or an
individual/customized application.

1.2.2 Leveraging Data Synergies

eCognition can fuse a variety of geospatial data, such as spectral image data, 3D structure data from point
clouds and spatial/thematic data from GIS vectors.

The proximity of eCognition to GIS, its ability to link and fuse the available data in an analysis - combined
with the straightforward export of results to GIS layers - help eCognition users to achieve outstanding
results.
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1   Overview

1.2.3 Efficient Workflows

The eCognition Suite offers three different components which can be used stand-alone or in combination to
solve even the most challenging fully automated and semi-automated production tasks:

l eCognition Developer is the development environment for object-based image analysis. It is used in
geospatial industry to develop Rule Sets or applications for eCognition Architect for the automatic
analysis of geospatial data.

l eCognition Architect enables non-technical professionals such as vegetation mapping experts, urban
planners or foresters to leverage eCognition technology. Users can easily configure, calibrate and
execute analysis applications (Rule Set in combination with a UI) created in eCognition Developer.

l eCognition Server software provides a powerful processing environment for batch and parallel
execution of analysis jobs, based on Rule Sets or applications.

eCognition Documentation | 3



1   Overview

1.3 eCognition Suite 10.3 Highlights

1.3.1 Python Integration

The new algorithm 'python script' allows python code to access and manipulate variables, vector, raster,
and point cloud data loaded in eCognition using available methods described in the Python API Reference.
The outputs created with python scripts are passed directly to eCognition and can be used for further
analysis. Python Environment Manager allows users to create environments with custom package
configuration. Debugging functionality allows users to attach any IDE that supports the 'debugpy' remote
debugger python module.

Python Integration - Python Script Algorithm
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1   Overview

1.3.2 Segmentation Preview

The Segmentation Preview is an interactive tool that allows users to test any segmentation algorithm
available in eCognition and calibrate its parameters on a selected area of the scene in a time-efficient way.
There is no need to create a scene subset. You can test and calibrate your segmentation using a rectangular
window that can be resized and moved to any location of the scene. The segmentation results will be
recalculated on the fly.

Tools - Segmentation Preview

1.3.3 Image Registration

A new 'image registration' algorithm is now available in eCognition 10.3. Image registration is an essential
preprocessing step in most cases when working with remote sensing imagery. Now users can build more
complete workflows in eCognition. The algorithm supports both automatic and manual registration
workflows as well as a direct homography matrix as input.

Image Registration (Image Courtesy Linz Data Service, creative commons license attribution 4.0)
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1   Overview

Image Registration Algorithm

1.3.4 Text Recognition

A new algorithm 'text recognition (OCR)' is now available. Based on optical character recognition
technology, it recognizes English text in images and converts it to text information.

Text Recognition Algorithm - OCR

1.3.5 User Interface & User Experience

Improving the user interface and user experience is one of the main highlights of version 10.3. In this
release we focused on the most frequent user requests including a Raster Calculator for the 'layer
arithmetics' algorithm that simplifies the process of building arithmetic expressions, a more interactive and
more functional 2D Feature Space Plot, and enabled multi-selection in the View Settings, Process Tree, and
Thematic Attribute table.

Layer Arithmetics Algorithm - Raster calculator
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New Features - Bug Fixes and
Limitations

2.1 New Features
New Features in eCognition 10.3:

Python Integration

New algorithm

The new algorithm 'python script' allows python code to access and manipulate
variables, vector, raster, and point cloud data loaded in eCognition using
available methods described in the Python API Reference. The outputs created
with python scripts are passed directly to eCognition and can be used for further
analysis. Additionally, we added a debugging functionality that allows users to
attach any IDE that supports the 'debugpy' remote debugger python module.

Deep learning

New Algorithm
A new algorithm 'text recognition (OCR)' is now available. Based on optical
character recognition technology, it recognizes the text in images and converts it
to text information. Currently, only the English language is supported.

New Parameter

Now users can optionally augment their data with the new parameter 'Add
sample augmentation' when creating labeled sample patches using the
algorithm 'generate labeled sample patches'. This will enhance the neural
network performance. Several augmentation techniques are supported.

New Parameter
Users can compute validation loss and training loss of their neural network
during training to detect underfitting or overfitting. The parameter is available in
the 'train convolutional neural network' algorithm.

New Option
The formerly 'apply instance segmentation' algorithm is now renamed to 'apply
object detection/instance segmentation' and supports object detection models
as well as instance segmentation models.

Tools

Segmentation
Preview

New tool Segmentation Preview to test segmentation algorithms and calibrate
parameters on a selected area of the scene in a time-effective way using a
window that can be resized and moved to any location. The segmentation
results are recalculated on the fly.

Point Clouds

2
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2   New Features - Bug Fixes and Limitations

New Algorithm
New 'rotate point cloud' algorithm allows to rotate a point cloud around a user-
defined origin point in the XYZ plane. The rotated point cloud is stored in a new
map.

New Feature
Coordinates of rotated point clouds produced with the 'rotate point cloud'
algorithm can be accessed via the feature 'X/Y/Z - rotated'. (Point features (point
cloud) > Rotation-aware fields.)

New Feature

New feature groups are available for point clouds - eigenvector and eigenvalues.
They calculate respectively values based on the input point cloud, which allows
getting spatial metrics the of a specified point cloud. (Map features > Point cloud
layer)

New Algorithm
New 'create temporary point cloud by filter' algorithm allows to produce new
point clouds by applying advanced filtering options. They offer more specialized
and efficient point cloud creation.

New Parameter

The existing 'transfer point cloud classification' algorithm now supports
transferring the point cloud classification between maps with the newly
introduced parameter 'destination map'. The added class filter allows the user to
control the classes that will be transferred.

User Interface

Improvement
eCognition 10.3 includes an enhanced 2D Feature Space Plot that offers more
functionality and interactivity for your data exploration and analysis of
relationships between objects of different classes.

Improvement

Raster Calculator is available for ‘layer arithmetics’ algorithm. The new dialog
makes it more convenient for users to build their arithmetic expressions using
the calculator interface. All available variables and image layers are listed in the
dialog.

Improvement
Multi-selection is now enabled in the View Settings window for image layers,
point clouds, vector layers, and image object levels. Additionally, multi-selection
is now possible in the Thematic layer attribute table and the process tree.

Improvement
'No color' option is now available for the outline color of image object levels.
This option helps to improve visualization when more than one image object
level is displayed.

Change
Now image layer aliases and thematic layer aliases can be modified in the same
window available via Process > Edit Aliases > Manage Layer Aliases.

Change Assign Projection and Reproject Data now can be found under Tools > Projection

Improvement

New option 'Snap 2D Vector To 3D Point ' in the context menu is available for
vector layers in the View Settings window. This option improves the display of
2D vectors in the 3D window by enabling a user to snap a selected 2D vector
layer to any 3D point selected in the 3D window.

Improvement
Now, when users switch back to single-pane view or they select a different split
option after splitting the view into several panes, they can expect the settings of
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2   New Features - Bug Fixes and Limitations

the last active pane to remain in the new split.

Improvement
Users have an option to hide expired licenses in the eCognition License
Manager.

Improvement Improved highlighting of the active tool in the toolbars of the main window.

Improvement

In the Feature View, the context menu for each feature 'Update Range' is
renamed to 'Calculate value range' to better reflect the functionality of the
option. Additionally, a new update control 'Update' is added to the feature
range check box for the active feature. This new button calculates the minimum
and maximum values for the active feature and can be used to reset the user-
defined minimum and maximum.

Improvement
New column 'Type' is added to the 'Object information' window. It displays the
calculated value type of the feature.

Improvement
Now users can expand or collapse all child processes of the selected parent
process in the Process Tree using the context menu options or shortcuts.

Improvement
When creating new classes in the Class Hierarchy window, each subsequently
created class receives a unique name and a new random color instead of the red
default color.

Improvement
Now users can control the number of decimal points displayed in the Object
Information window. The new global option is available in Tools > Options >
Display > Number of digits to display after decimal place in object information.

Improvement Algorithm search in the Edit Process window now supports keywords.

Improvement Users can open projects in the trial version of eCognition Developer.

New Algorithms, Parameters & Features

New Algorithm
New 'image registration' algorithm is now available. The algorithm supports
both automatic and manual registration workflows as well as homography
matrix as input.

New Feature
New object feature 'Pixel value range' calculates the pixel range of image objects
(Object features > Image Layer > Pixel based > Pixel value range).

New Operator
Not-equal-to operator '<>' is now available for building arithmetic expressions
and in the Edit Condition dialog.

New Option
New mode 'Shuffle' is available in the 'update array' algorithm. Randomly
shuffles the array.

Improvement The 'image object fusion' algorithm now supports multiple fitting functions.

New Parameter
A new group of parameters 'Vector attribute merge settings' is added to the
'vector dissolve' algorithm that allows users to select attributes for merged
vectors.
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2   New Features - Bug Fixes and Limitations

2.2 Bug Fixes
Bug Fixes and Improvements in 10.3:

Bug Fixes

Bug Fix
When working with a large image, and zoomed out in view of the entire image,
using the area-zoom tool (Ctrl-U) can cause the view to zoom out to full extent.

Improvement
Improved behavior of the Nearest Neighbors Feature Space functionality and
added a progress bar.

Bug Fix
Exporting thematic raster files as ERDAS IMAGINE .img file resulted in the first
class turning into "unclassified".

Bug Fix
Fixed issue of Time Series tool bar staying grayed out after customized frame
import.

2.3 Known Issues and Limitations
The eCognition License Server does not support the web interface on Linux distribution CentOS 6 (license
server startup script needs to be modified to use -noWeb option for lmadmin).

Please contact support if you have further questions.
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Portions of this product are based on third-party software components. Trimble is required to include the
following text, related to software and distributions. The most recent version of this document can be
found in the installation folder of eCognition (C:\Program Files\Trimble\eCognition Developer
10.3\bin\third-party-acknowledgements.txt).

OpenCV, The Open Source Computer Vision Library

Version 4.5.1 

Copyright (c) 2020, Intel Corporation

https://opencv.org/  

License: Apache 2 License   

Snappy 

Version 1.0.5

Copyright (c) 2005 Google Inc. 

https://github.com/google/snappy  

License: Snappy License  

ZLIB Data Compression Library 

Versions 1.2.3 and 1.2.11

Copyright (c) 1995-2017 Jean-Loup Gailly and Mark Adler  

https://zlib.net/ 

License: GNU Lesser General Public License  

CPPREST 

Versions 2.9.1 and 2.10.6 

Copyright (c) 2019 Microsoft Corporation 

https://github.com/microsoft/cpprestsdk 

License: MIT License 
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GLEW 

Version 2.1.0 

Copyright (c) 2002-2007, Milan Ikits  Copyright (c)  2002-2007, Marcelo E. Magallon

Copyright (c) 2002, Lev Povalahev 

http://glew.sourceforge.net/ 

License: BSD License and MIT License 

Mesa 3-D graphics library 

Version 7 

Copyright (c) 2015 The Android Open Source Project 

https://www.mesa3d.org/ 

License: Apache 2.0 

Geogram 

Version 1.3.9 

Copyright (c)  2012-2014 Bruno Levy 

http://alice.loria.fr/software/geogram/doc/html/geogram_license.html 

License: BSD License 

LASZIP 

Version 3.1.0 and 3.4.3

Copyright(c) 2007-2017, Martin Isenburg 

https://laszip.org/ 

License: LGPL  

DEVIL 

Version 1.7.8 

Copyright (c) Project Contributors 2019 

http://openil.sourceforge.net/ 

License: LGPL 2.1

Nanoflann 

Versions 1.3.0  and 1.4.2

Copyright 2008-2009 Marius Muja  Copyright  

Copyright 2008-2009 David G. Lowe (lowe@cs.ubc.ca). All rights reserved.
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Copyright 2011-2022 Jose Luis Blanco (joseluisblancoc@gmail.com). All rights reserved.

https://github.com/jlblancoc/nanoflann 

License: BSD License 

Ifcplusplus

Version 1.1

Copyright 2010-2015 Fabian Gerold

https://github.com/ifcquery/ifcplusplus

License: MIT License

Boost

Version 1.79

Copyright Beman Dawes, Daniel Frey, David Abrahams, 2003-2004.

Copyright Rene Rivera 2004-2005.

https://boost.org

License: Boost Software License, Version 1.0

Crypto++

Version 7.0.0

Compilation Copyright (c) 1995-2018 by Wei Dai.  All rights reserved.

https://cryptopp.com

License: Boost Software License, Version 1.0

CUDA & cuDNN

Version 11.2

Copyright © 2020 NVIDIA Corporation

https://developer.nvidia.com/cuda-toolkit

https://developer.nvidia.com/cudnn

License: Boost Software License, Version 1.0

DejaVu

Version 2.30

Copyright (c) 2003 by Bitstream, Inc. All Rights Reserved. Bitstream Vera is trademark of Bitstream,
Inc.

Copyright (c) 2006 by Tavmjong Bah. All Rights Reserved.
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https://dejavu-fonts.github.io/

License: DejaVu Fonts — License

File-geodatabase (FileGDB)

Version 1.5.1

Copyright 2017 Esri 

https://github.com/Esri/file-geodatabase-api

License: Apache License 2.0

PGR Ladybug

Version 2.12.3

Copyright © 2017 FLIR Integrated Imaging Solutions, Inc. All Rights Reserved. 

http://www.ptgrey.com

License: PGR Ladybug® SDK License

Ffmpeg codec

Version N-78758-g5156578

Copyright © 2000-2016 FFmpeg Project

https://ffmpeg.org

License: LGPL 2.1+

Freetype

Version 2.9

http://www.freetype.org

Copyright 1996-2002, 2006 by David Turner, Robert Wilhelm, andWerner Lemberg

License: The FreeType Project LICENSE

GDAL

Version 3.2.3

https://gdal.org

© 1998-2022 Frank Warmerdam, Even Rouault, and others

License: GDAL License (https://gdal.org/license.html)

GeoGram
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Version 1.3.9 

https://github.com/BrunoLevy/geogram

Copyright (c) 2012-2014, Bruno Levy All rights reserved.

License: BSD 3-Clause "New" or "Revised" License

Graphic gems

Version 1.0

"Graphics Gems" (editor, Andrew S. Glassner, published by

Academic Press, Cambridge, MA, 1990, ISBN 0-12-286165-5, 833 pgs.).

License: Graphic gems license

Graphic gems

Version 1.0

"Graphics Gems" (editor, Andrew S. Glassner, published by

Academic Press, Cambridge, MA, 1990, ISBN 0-12-286165-5, 833 pgs.).

License: Graphic gems license

gSOAP

Version 2.7.9

https://www.genivia.com/dev.html

Copyright (C) 2000-2005 Robert A. van Engelen, Genivia, Inc. All Rights Reserved.

License: gSOAP Public Open Source License (Version 1.3a)

Info-Zip

Version 1.01e

http://www.info-zip.org

Copyright (c) 1990-2007 Info-ZIP.  All rights reserved.

License: Info-Zip license (BSD-based)

Intel® Integrated Performance Primitives

Version 2018.0.2

https://www.intel.com/

Copyright (c) 2018 Intel Corporation.

License: Intel Simplified Software License (Version January 2018)
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Jasper

Version 2.0.14

https://github.com/jasper-software/jasper

Copyright (c) 2001-2016 Michael David Adams

Copyright (c) 1999-2000 Image Power, Inc.

Copyright (c) 1999-2000 The University of British Columbia

License: JasPer License Version 2.0

LASZip

Version 3.1.0

https://laszip.org/

Copyright (c) 2007-2017, Martin Isenburg, rapidlasso - fast tools to catch reality

License: LGPL 2.1

libGeoTiff

Version 1.2.5

https://github.com/OSGeo/libgeotiff

Copyright (c) 1995 Niles D. Ritter

Copyright (c) 1999, Frank Warmerdam

License: libgeotiff license

Libjpeg

Version 9b, 17-Jan-2016

http://libjpeg.sourceforge.net/

Copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.

License: Libjpeg License

Libpng

Version 1.6.37

http://www.libpng.org/pub/png/libpng.html

Copyright (c) 1995-2019 The PNG Reference Library Authors.

Copyright (c) 2018-2019 Cosmin Truta.

Copyright (c) 2000-2002, 2004, 2006-2018 Glenn Randers-Pehrson.

Copyright (c) 1996-1997 Andreas Dilger.
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Copyright (c) 1995-1996 Guy Eric Schalnat, Group 42, Inc.

License: PNG Reference Library License version 2

Libpng

Version 1.6.37

http://www.libpng.org/pub/png/libpng.html

Copyright (c) 1995-2019 The PNG Reference Library Authors.

Copyright (c) 2018-2019 Cosmin Truta.

Copyright (c) 2000-2002, 2004, 2006-2018 Glenn Randers-Pehrson.

Copyright (c) 1996-1997 Andreas Dilger.

Copyright (c) 1995-1996 Guy Eric Schalnat, Group 42, Inc.

License: PNG Reference Library License version 2

Mesa 3-D

Version  7.0

https://www.mesa3d.org/

Copyright (c) 2015 The Android Open Source Project 

License: Apache 2.0

MrSid DSDK

Version 9.5.4

Copyright (c) 2010 - 2017 Celartem Inc. d.b.a. LizardTech.

LizardTech Computer Software License Agreement for MrSID Decode SDKs

License: LizardTech Computer Software License Agreement for MrSID Decode SDKs

NSIS

Version 3.6.1.0

https://nsis.sourceforge.io/

Copyright (c) 1999-2020 Contributors

License: Common Public License version 1.0

OpenGL Extension Wrangler Library

Version 1.1

http://glew.sourceforge.net/

Copyright (c) 2007 The Khronos Group Inc. All rights reserved.

eCognition Documentation | 17



3   Acknowledgments

License: Modified BSD License, the Mesa 3-D License (MIT) and the Khronos License (MIT).

Pybind11

Version 2.9.2

https://github.com/pybind/pybind11

Copyright (c) 2016Wenzel Jakob <wenzel.jakob@epfl.ch>, All rights reserved.

License: pybind free license

OpenMP

Version 5.0 (part of IPP)

https://www.openmp.org/

Copyright (c) 2005-2014 Intel Corporation. All rights reserved.

License: Intel Simplified Software License (Version January 2018)

Shapelib

Version 1.92 (part of GDAL)

https://gdal.org

Copyright (c) Frank Warmerdam

License: GDAL License (https://gdal.org/license.html)

SQLite

Version 3.3.03.3.0

https://www.sqlite.org/

Copyright: Public Domain

License: doesn’t require a license

TensorFlow

Version 2.5

https://www.tensorflow.org/

Copyright (c) Google Inc., Yuan Tang <terrytangyuan@gmail.com>, Arm Ltd

License: Apache 2 License

Tesseract library

Version 5.1.0
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https://github.com/tesseract-ocr/tesseract

Copyright (c) Tesseract authors

License: Apache 2 License

wkhtmltopdf executable

version: 0.12.3.2

https://wkhtmltopdf.org/

Copyright (c) 2010-2014 wkhtmltopdf authors

License: LGPL v3

Python

Version: 3.9.12

https://www.python.org/

Copyright (c) 2001-2022.  Python Software Foundation

License: Python Software Foundation Version 2

pip

Version: 22.0.4

https://pip.pypa.io/en/stable/

Copyright (c) 2008-present The pip developers

License: MIT License

Setuptools (Python library)

Version: 58.1.0

https://github.com/pypa/setuptools

Copyright Jason R. Coombs

License: MIT License

python-dateutil (Python library)

Version: 2.8.2

https://github.com/dateutil/dateutil

Copyright (c) 2003-2011 - Gustavo Niemeyer <gustavo@niemeyer.net>

Copyright (c) 2012-2014 - Tomi Pieviläinen <tomi.pievilainen@iki.fi>

Copyright (c) 2014-2016 - Yaron de Leeuw <me@jarondl.net>

Copyright (c) 2015- - Paul Ganssle <paul@ganssle.io>
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Copyright (c) 2015- - dateutil contributors (see AUTHORS file)

License: Apache License Version 2 and BSD 3-Clause License

numpy (Python library)

Version: 1.22.4

https://numpy.org/

Copyright (c) 2005-2022, NumPy Developers

License: BSD 3-Clause

pandas (Python library)

Version: 1.4.2

https://pandas.pydata.org/

Copyright (c) 2008-2011, AQR Capital Management, LLC, Lambda Foundry, Inc. and PyData
Development Team All rights reserved.

Copyright (c) 2011-2021, Open source contributors.

License: BSD 3-Clause

pytz (Python library)

Version: 2022.1

https://pythonhosted.org/pytz/

Copyright (c) 2003-2019 Stuart Bishop <stuart@stuartbishop.net>

License: MIT License

Shapely (Python library)

Version: 1.8.2

https://github.com/shapely/shapely

Copyright (c) 2007, Sean C. Gillies

License: BSD 3-Clause

six (Python library)

Version: 1.16.0

https://github.com/benjaminp/six

Copyright (c) 2010-2020 Benjamin Peterson

License: MIT License
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debugpy (Python library)

Version: 1.6.3

https://github.com/microsoft/debugpy/

Copyright (c) Microsoft Corporation

License: MIT License

SciPy (Python library)

Version: 1.9.3

https://scipy.org/

Copyright (c) 2001-2002 Enthought, Inc. 2003-2022, SciPy Developers.

License: BSD 3-Clause
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